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1. Disclaimer

The Transportation Model has been developed by National Grid to seek to enable
transparency of its Gas Charging Methodology in respect of the GB National Transmission
System (NTS), and is provided on this understanding. This document is not intended to give a
detailed account of the capacity charging methodology; pricing papers and detailed
supporting documentation are available on our website at:

http://www.nationalgrid.com/uk/Gas/Charges/

The model has been developed using Microsoft Office Excel 2007 (please see Appendix 4 for
further information about Excel 2007), and tested on National Grid’s company operating
system (based on Windows XP). The Transportation Model is expected to perform as
described below on similar Microsoft Windows based systems such as Windows
2000/Windows NT, however, National Grid cannot guarantee the correct behaviour of the
model when operated on other systems.

Before using the model, users are asked to satisfy themselves that they are able to comply
with the terms of the NTS Charging Model Software Licence Agreement that sets out the
terms on which National Grid provide this software.
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2. Introduction

National Grid NTS is subject to Transportation Owner (TO) and System Operator (SO) Price
Controls set by Ofgem. The allowed revenue, defined by the Price Controls, is collected as
follows:

NTS TO Allowed Revenue

Revenue from other charges (under/over recovery from the previous formula year ‘K’, DN
Pensions deficit revenue and metering revenue) is first deducted.

50% of the remaining NTS TO Allowed Revenue is collected from entry charges from the sale
of non-incremental obligated entry capacity. A TO Commodity Charge may be levied to adjust
for under or over-recovery (negative charge applied in case of over-recovery).

The other 50% of the remaining NTS TO Allowed Revenue is collected from exit capacity
charges, which are applied on an administered peak day basis. These charges are based on
Long Run Marginal Cost (LRMC) of developing the system to meet increased demand and
are determined by exit zone.

NTS SO Allowed Revenue

The NTS SO Allowed Revenue is collected largely by means of an NTS Entry Commodity and
Exit Commodity charge. This is a uniform charge, independent of entry and exit points, and is
levied on both NTS entry and NTS exit flows.

Revenues are also collected from charges for incremental entry and incremental exit capacity.

The Transportation Model is concerned with setting entry capacity auction reserve prices and
exit capacity charges. It is also used for setting indicative exit capacity charges when
required. For further details of Commodity Charges please see the Quarterly Charge Setting
Reports located at http://www.nationalgrid.com/uk/Gas/Charges/Tools.
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3. Notes on the Transportation Model

3.1 Terminology

The title “Transportation Model” represents the complete process of calculating the costs
associated with transporting each unit of gas through the National Transmission System
(Transport Model) and the conversion of these costs into prices (Tariff Model). Note the Tariff
Model comprises of two halves, Raw (Unadjusted) Prices and Administered Exit Prices.

3.2 Microsoft Excel Solver Add-in

The Microsoft Excel Solver Function needs to be activated for the Transportation Model to
work. If it has not already been activated, this can be done as follows:

1. Open the Transportation Model (see section 3.5 for further detail).

2. Select Tools>Add-Ins in the menu bar (If using Excel 2007, select Excel Options>Add-
Ins>Manage Excel Add-ins>Go...).

3. Tick the Solver Add-in tick box to activate the Solver function.

4. Click OK.

3.3 Spreadsheet Protection

Please note the Transportation Model spreadsheet is not protected as it will not be able to
function with protection enabled. It is therefore advisable to keep a master original copy in
case unwanted changes are accidentally saved by the user.

3.4 Navigating the Transportation Model

Upon opening the Transportation Model a dialog box will display as shown in Figure 1. Select
Enable Macros to proceed. (Please see Appendix 4 for further information on using the
Transportation Model in Excel 2007).

Security Warning EI

"C:Documents and Settings\Richard. Hounslea\Deskrop| Transpartation Madel
Oct 2010 Exit MSEC \xls" contains macros,

Macros may conkain viruses, It is usually safe to disable macros, but if the
macros are legitimate, wou might lose some functionality,

Disable Macros

 Enable Macros | [ More Info

Figure 1: Security Warning

The second sheet of the workbook is named Exit Capacity Prices, and it is only this
worksheet that should be referred to in relation to exit prices (see Section 4 for more details).

Both obligated (non-incremental) and incremental entry prices can be viewed in the Entry
Capacity Prices sheet (see Section 5 for details).
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3.5 Navigating the Exit Capacity Prices worksheet

Exit capacity prices are calculated using the Exit Capacity Prices worksheet within the
Transportation Model (click on the Exit Capacity Prices tab at the bottom of the workbook).
The Transport Model controls are located in cells G20:J25.

The Tariff Model comprises two halves; Raw (Unadjusted) Prices and Administered Exit
Prices. The controls for Unadjusted Prices are located in cells L20:S25, and the controls for
Administered Exit Prices are located in cells U20:AC27. (Note: the Administered Exit Prices
take the negative of the raw LRMCs derived from the Transport Model and adds on the
revenue adjustment factor. Essentially, columns L to S show how Entry prices are calculated).
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Figure 2: Exit Capacity Prices worksheet
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3.6 Navigating the Entry Capacity Prices worksheet

Obligated (non-incremental) and incremental entry capacity prices are calculated within the
Entry Capacity Prices worksheet (click on the Entry Capacity Prices tab at the bottom of the
workbook). The controls are located to the right of the data tables in cells M25:038.
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Figure 3: Entry Capacity Prices worksheet
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4. Calculating Exit Capacity Prices

As mentioned in Section 3.5, it is the Exit Capacity Prices worksheet which should only be
referred to in relation to exit prices. The function of the worksheet can be summarised as
follows:

1. The Transport Model (cells G20:J25) is run to calculate the LRMCs.

2. The LRMCs feed into the first part of the Tariff Model, Tariff Model — Raw (Unadjusted)
Prices, which is run to calculate unadjusted entry and exit prices (columns L - S). This
Tariff Model simultaneously ensures a 50/50 split between adjusted entry and exit prices,
using the Adjustment Factor. This part of the model calculates Entry Capacity prices
based on the Supply and Demand Balance, however actual Entry Capacity prices are
shown within the Entry Capacity Prices worksheet.

3. The negative of the raw LRMCs derived from the Transport Model (i.e. a positive Entry
LRMC in column J becomes a negative Exit LRMC in columns V to X) then feed into the
second part of the Tariff Model, Tariff Model - Administered Prices (columns U — AC),
which applies a Revenue Adjustment Factor to the LRMCs so that the Exit Revenue
derived from the Exit Capacity charges equals the Target Exit Revenue.

It is the Tariff Model (Administered Prices) that should be referred to for exit prices.
More details on the above steps can be found in Sections 4.1 —4.2.2
4.1 Running the Transport Model

4.1.1 Calculating LRMCs

Click on Clear LRMCs followed by Calculate LRMCs within the Transport Model controls,
circled in the below screenshot.

The flow results (column E) and LRMCs (column J) should be updated in the Pipe Data and
Node Data sections respectively. If required, a different Reference Node may be selected
within the model controls and the LRMCs cleared and recalculated.

B3 Microsoft Excel - Transportation Model Oct 2010 Exit MSEC

PE] Fle Edt View Insert Fomat Took Data  Window  Help Type aquestionforhelp = _ @ X
NN BT N2 A WY e R e S N e | P N T e M
TargetExitRey = A 19251
Al I -— [ c | o | E | F | G T H T ] T J | K T L | M | N | [=] | F | 7

i
2 /
R
maai
[
| & | |botes
=
6 | |nEnyLAMEs sre onlysted as th o calculste the st LRMICs (an evit LRME for sn exit y LAMC for
3 yprices

2] all entry and exit points.

2 d does net

4 et prises are ! Hior app

Calou ey T

 Larift Model - Raw (Unadjusted) Prices
faerags Entry LAMC
Reference Node: | PETERBOROUGHTEE | Annuitisation Fastar: EEE ferage Exit LAMC
8 | put Enpansion Constant; [ 2559 asGvhkm Adiustment
7| [Black Text Headingsil otal 561782 GWh _ Total Demand - o
9| [PipeData [Node Data Tarifts - Raw (Unady Entry and Exit Prices
Swply|  Deman Amc EwrrFlow|  LRMC| (prkwhras i
| 30 | |mtee Outler Hode (CWh) (CWh) [km) Entry Paint (EWh) (k=) #) | Exit Point
31| [sBeroeen CaRESTON MEERDEEN 00 By AT AVONMIOUTH_LNG 000 000 00001 ABERDEEN
(47| |MuREwas wm AUSTREY AUSTRET 0| 523 GLERIMAYIS_LNG o) 18134] 00751 ATLESBEARE
[ 38| |aspier AUDLEY Wt AVLESBEARE a.00) 3415 HORMSEA IMRS) 00| H3.33) 0,005 | BALOERSEY
47| |aunEvnw HOLMES._ CHAPEL EACTON_TERMINAL 18040 w50 MILFORD_HAVEN_TERMINAL | 2se0s|  wes| 0
49 AUDLEY_wh ALREWAS_Wh BALDERSET o £.30 ST_FERGUS_TERMIMAL 1346.52) LLEEH 0.035% | BISHOP_ALCKLAND
T SEABAHIPOWER_I BARTOM_STACEY oa ) S SATENDL P
65| |avieseesre KEIL_SOUTH EARTO_ STACEY_(MRS) o 21960 BRASHFIELD_A
56| |srieseunr cHALGROVE EELTORT om) e SRIGE_PG
59| |escron_TeRmmAL sacTon_or ELLNGHARLICH o 1 BRIMSDOWH_FG
| 60| |BacTonTeRMIAL BRsLEY EIRCH_HEATH o e BRSLEY
[ 63| |eacTon TeRmmaL KINGT_LYHA_COMP ELACKERIDGE 050 2113) BURLEY_BANK
(67| |esomar Eoon o (e CHESHRE. (MRS)
| 68| |BammmGTon OTTERY_ST_MARY BP_GRANGEMOLTH 0| 208.82| CIRENCESTER
[ 72| |samTon sTacer EARTON_STACEY_[MRS) ERIDGE_FARM 000 313 CORERIDGE
74| [esron_sracer MICHELMERSH BRIGE_PG 0 5506 corvTon_pG
| 75| |Bamneate ARMADALE ERMSDON_ PG o 15359 comTam_ o
76| |mamhoaTe ELanrDaT BRISLEY o) 7434 COWFEN_BEVLEY
76| |Bamheate GLENMAYS ERTISHSUGAR YORK 0 a6.00) DEESIDE_PS
| 75| |seeForo GANSTEAD EROCKLESEY 0| 22| DIDCOT_PS
80| |meorr HATFIELD,_MDOR,_ (MRS ERoXEURN o 6. oowLAE
Ea Y MICKLE_TRAFFORD EURTON_PORNT_TERMNAL 201 21545 TERMI
A E ) eTon ceupecorT om) 1083 ERSTOR_GREY
50| |euackermnoe NEWTON_DYES CAYTHORBE (MRS) o s0.61 EvEsHam
55| |euveorouc comTam_pa CHOAKFORD o 42501 GARSTEAD
87 EOOM HUME 16.25] 0.0¢ CHURCHOYER_COMP_TEE 0.00) 5152 GILWERN b
W« » i\ Front Shest 3, Exit Capacity Prices { Entry Capaci es [< >
Filter Mode NUM

Figure 4: The Transport Model
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Once the LRMCs have been calculated, the Tariff Models may be run. There is no need to
rerun the LRMCs if switching between the different Tariff Models. However, the LRMCs will
need to be cleared and recalculated if the pipe data or node data is changed. The Reset
Ranges button will need to be used before recalculating the LRMCs if additional pipe or node
data is entered by the user.

4.2 Running the Tariff Models

4.2.1 Calculating Entry and Exit Prices Based on a 50:50 Entry-Exit Split

Click on Reset Adjustment Factor followed by Calculate Entry Prices within the “Tariff
Model — Raw (Unadjusted) Prices” controls, circled in Figure 5.
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Figure 5: The Tariff Model — Raw (Unadjusted) Prices

The data in the Tariffs — Raw (Unadjusted) Entry and Exit Prices section (columns L - S) of
the spreadsheet will be updated. Note that both entry and exit prices are simultaneously
updated. The calculated Adjustment (Factor) can be seen in the Tariff Model — Raw
(Unadjusted) Prices controls.
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4.2.2 Calculating Administered Exit Prices to meet a Target Exit Revenue

Click on Reset Revenue Adjustment Factor followed by Calculate Exit Prices within the
Tariff Model - Administered EXxit Prices controls, circled in Figure 6.
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Figure 6: The Tariff Model - Administered Exit Prices
The data in the Tariffs — Administered Exit Prices section (columns U - AC) of the
spreadsheet will be updated. Note that DN (zonal) Prices (column AC) are simultaneously
updated.

The calculated Revenue Adjustment Factor “Adjustment” can be seen in the Tariff Model -
Administered Exit Prices controls.

Nodal and zonal charges may also be viewed via the drop-down lists.
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5. Calculating Entry Capacity Prices

Obligated (non-incremental) and incremental entry capacity reserve prices (P, prices) are
calculated in the Entry Capacity Prices sheet.

This can be done as follows:

1. Click on Reset Ranges before performing any analysis to ensure the model functions
correctly.

2. Then either:

a. Select the desired entry point from the drop-down list in the model controls (columns M
— 0) and click on Analyse Selected Supply.

Or;
b. Click on Analyse All Supplies within the model controls.

The Nodal Marginal Distance, Initial Price Schedule and Final Price Schedule tables will all be
updated for the selected supply/all supplies.

The Final Price Schedule is determined by adjusting the Initial Price Schedule to ensure there
is a minimum price step size between successive price steps.

Note that the Transportation Model will generate an Excel file for each supply point that is
considered - the files will be saved in the same location as the Transportation Model. The
generated files do not need to be viewed - they contain more detailed data, which is used to
populate the Entry Capacity Prices sheet within the Transportation Model.
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Figure 7: The Entry Capacity Prices worksheet
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6. Performing Simple “What-if” Scenario Analysis
6.1 Scenario Analysis — “Exit Capacity Prices” Sheet

6.1.1 Changing the Reference Node

The user can change the Reference Node within the Transport Model to observe the effects
on the nodal LRMCs. However, it should be noted that this will not affect the final tariffs in
either of the two tariff models, as these work by re-referencing the LRMCs to achieve a 50:50
entry-exit split or target exit revenue.

6.1.2 Changing the Annuitisation Factor

The user may change the Annuitisation Factor within the Tariff Model — Raw (Unadjusted)
Prices) as determined by National Grid’s NTS Licence to observe the effects on the tariffs in
either of the two Tariff Models. This will not affect the LRMCs calculated within the Transport
Model.

6.1.3 Changing the Expansion Constant

The user may change the Expansion Constant within the Tariff Model — Raw (Unadjusted)
Prices) to observe the effects on the tariffs in either of the two Tariff Models. This will not
affect the LRMCs (marginal distances) calculated within the Transport Model.
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Figure 8: Changing the Reference Node, Annuitisation Factor
and Expansion Constant

6.1.4 Changing the Target Exit Revenue

The user may change the Target Exit Revenue within the Tariff Model - Administered EXxit
Prices controls to observe the effects on the Administered Exit Prices. This will not affect the
LRMCs calculated within the Transport Model or the tariffs calculated from assuming a 50:50
entry-exit split.
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6.1.5 Changing Supply and Demand Flows

The user may overwrite the supply or demand data for any node and rerun the Transport
Model and Tariff Models to see the effect on capacity prices. The total supply and total
demand figures are displayed at the top of the Node Data section to help with achieving a
balanced network. If these totals aren’t in balance, the Transport Model will automatically
scale the supplies (uniformly) to meet the total demand and hence prices will be less
representative.
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Figure 9: Changing the Supply and Demand Flows

6.2 Scenario Analysis — “Entry Capacity Prices” Sheet

6.2.1 Calculating Incremental Entry Capacity
Incremental entry capacity can be calculated as follows:

1. Click on Reset Ranges before performing any analysis to ensure the model functions
correctly.

2. Select the desired entry point from the drop-down list in the model controls (columns M —
0O)

3. Select the number of required incremental steps (column F) and the step size (column G)
for each supply point in the data table.

Note: Size of increment = number of steps x step size

The user can choose a different number of increments for each supply point. If the user
chooses zero increments then only the PO price will be calculated. If the user chooses five
increments then the PO — P5 prices will be calculated.

Please refer to the Incremental Entry Capacity Release Methodology Statement, which can
be accessed at the following links, for details on selecting the number of required increments
and size of step.

http://www.nationalgrid.com/uk/Gas/Charges/statements/
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http://www.nationalgrid.com/NR/rdonlyres/3FE02C8B-3FC1-40E0-9528-
F2ED634015AD/44391/IECRv11approvedi.pdf

4. Click on Analyse Selected Supply or Analyse All Supplies within the model controls.

The Nodal Marginal Distance, Initial Price Schedule, Final Price Schedule, and Estimated
Project Value tables will all be updated for the selected supply/all supplies.
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Figure 10: Changing the number of Increments and size of step

Note that the Transportation Model will generate an Excel file for each supply point that is
considered - the files will be saved in the same location as the Transportation Model. The
generated files do not need to be viewed - they contain more detailed data, which is used to
populate the Entry Capacity Prices sheet within the Transportation Model.
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7. Performing More Extensive Scenario Analysis

7.1 Adding a New Exit Point
It is advisable to save a separate copy of the Transportation Model for scenario analysis.

It is possible to add a new exit point into the model in the Exit Capacity Prices worksheet. All
new exit points must be connected to a pipe in the network and all pipes must be connected
such that there are no isolated sections of the network. In this example we are going to add a
new exit point halfway between Horndon and Stanford le Hope (current pipe length 4.06km).

1. Select the Exit Capacity Prices worksheet.

2. Select the Add a New Entry / Exit Point button (cells 12:K4) to bring up the window as in
Figure 11.

Add A New Entry / Exit Point

) I 3 v J_ o

NEW_EXIT HORNDON -

Populate and Close

Figure 11 — the Add a New Entry / Exit Point window
3. In this example please note the following;
e The New Exit Point check box has been selected.
¢ In the New Node text box “NEW_EXIT” has been entered as the new exit point name,
and “HORNDON?” has been selected as the Existing Node.

e The Demand quantity (GWh/d) has been entered as “10”.
e The Length of pipe (km) has been entered as “2”.

4. Select Populate and Close.
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5. The result is that an existing /nlet “"HORNDON” has been added to the bottom of the Pipe
Data section in column B as has the new exit point, “NEW_EXIT”, which will be connected to
the network. The pipe length between the two nodes has also been entered as “2.00” (km).

6. We have effectively split the pipe that existed between HORNDON and
STANFORD_LE_HOPE into two sections...almost! For completeness, we will now manually
enter the remaining information to complete the pipe section between NEW_EXIT and
STANDFORD_LE_HOPE as in Figure 12. The remaining pipe length is derived from 4.06km
— 2km = 2.06km.

Note: you do not need to enter flow data in column E as this will be populated when the
Transport Model is run. Also note that the model is case sensitive i.e. “NEW_EXIT” is different
to “New_Exit”, and separate words also need to be joined by using an underscore.
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Figure 12: Completing the Pipe Data section
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7. Navigate to the Node Data table (columns G - J) and you will notice that it has been
updated with “NEW_EXIT” at the bottom of Node (column G), as shown in Figure 13. The
demand of “10.00” (GWh) has also been entered in column I, and a supply of “0.00” entered
in column H (Supply will always be zero in the case of new exit points).

Note: you do not need to enter LRMC data in column J as this will be populated when the
Transport Model is run. Also note that adding demand data for the new exit point will result in
a supply / demand imbalance; however, the Transport Model will automatically scale the
supply data to match demand. This will happen within the Model and will not change the
entered data.
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Figure 13: NEW_EXIT and supply / demand data added to the Node Data table
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8. Navigate to the Tariffs — Raw (Unadjusted) Entry and Exit Prices table (columns L — S).
You will notice that “NEW_EXIT” has been added to the bottom of Exit Point column (column
P), as shown in Figure 14, and that the following formulae from the row above have been
copied down to the new row entry;

Exit Flow (column Q)
Exit LRMC (column R)
Exit Price (column S)

The cells may display “#N/A” but this is expected at this stage.
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Figure 14: the updated Tariffs — Raw (Unadjusted) Entry and Exit Prices table
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9. Navigate to the Tariffs — Administered Exit Prices table (columns U — AC). You will notice
that “NEW_EXIT” has been added to the bottom of Exit Point column (column U) and that the
flow data and formulae from the row above have also been copied down to the new row.

NB: The value for flow (demand) data should be the same as entered earlier in this process
i.e. “10”; however, because the data from the row above has been copied down, in this
example, “60” has been copied to “NEW_EXIT”. This needs to be amended manually.

If “NEW_EXIT” is a Distribution Network Zone enter the relevant code in DN Exit Zone
(columnY), otherwise leave this cell blank. Copy the formulae from the following columns into
the new row;

DN Offtake Flow (column Z)
Flow”Exit Charge (column AA)

Again, the cells may display “#N/A” — this is expected at this stage.
10. Click on Reset Ranges in the top left-hand corner of the worksheet. The Transport Model
and Tariff Models can then be run as normal. The results can be viewed in the Tariffs —

Administered Exit Charges table (columns U — AC).

Note that “NEW_EXIT” will not appear in the drop-down lists in the Transport Model and Tariff
Model. The user has the choice to either:

a. Manually type “NEW EXIT” in the drop down box, overwriting the displayed exit point.
Or;
b. Save, close and re-open the spreadsheet, which will allow the drop-down list to refresh.

“NEW_EXIT” will then appear at the bottom of the drop-down lists in the Transport Model
and Tariff Model - Administered Exit Prices controls.
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7.2 Adding a New Entry Point
It is advisable to save a separate copy of the Transportation Model for scenario analysis.

It is possible to add a new entry point into the model in the Exit Capacity Prices worksheet.

Incremental entry capacity requested in Gas Year 0 will be released in Gas Year 4. The
Transportation Model relevant to Gas Year 3 will be used to calculate the entry capacity
auction reserve prices for Gas Year 4. For example, if incremental entry capacity is requested
through the 2011 QSEC auction, the 2013/14 Transportation Model will be used to calculate
the price schedule.

Please refer to the Incremental Entry Capacity Release Methodology Statement, which can
be accessed at the following links, for details on selecting the number of required increments
and size of the step.

http://www.nationalgrid.com/uk/Gas/Charges/statements/

http://www.nationalgrid.com/NR/rdonlyres/3FE02C8B-3FC1-40E0-9528-
F2ED634015AD/44391/IECRv11approvedi.pdf

A Note on New Entry Points

The Transportation Model will not produce the correct incremental prices under two
circumstances:

1. If a new entry point is directly connected to an existing entry point via a minimum
connection (i.e. a pipe length of Okm between the Inlet and Outlet in the Pipe Data table
in the Entry-Exit worksheet)

2. If a new entry point is connected to an existing node that is connected to an existing
entry point via a minimum connection.

This can be overcome by entering a small connection (e.g. 0.01km) between the Inlet and
Outlet in the Pipe Data table.

Example: Direct Minimum Connections to Existing Entry Points
The user connects a new entry point, in this example “New Entry”, to existing entry point

“Entry Point A” with a minimum connection. The Transportation Model will calculate that they
are in the same location and perform all analysis based on only one of the entry points.

If the user enters a length of Okm between the two NEW ENTRY ENTRY POINT A
entry points in the Pipe Data table, the
Transportation Model will treat the two sites as \ /
one entry point and will not function correctly. @
+«—>
Okm

Example: Indirect Minimum Connections to Existing Entry Points

The user connects a new entry point in this
example “New Entry” to existing node “Node A” NEW ENTRY ENTRY POINT A

with a minimum connection. \3"_’“>/

However, Node A is connected to existing
entry point “Entry Point A” with a minimum Okm\ /0km
connection. T

NODE A

Therefore, New Entry is indirectly connected to
Entry Point A with a minimum connection.

The Transportation Model will calculate that New Entry and Entry Point A are in the same
location and perform all analysis based on only one of the entry points.
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A new entry point can be added as follows:

1. Select the Exit Capacity Prices worksheet.

2. Select the Add a New Entry / Exit Point button (cells 12:K4) to bring up the window as in
Figure 15.

Add A New Entry / Exit Point

o | |

NEW_ENTRY HORMDON o

Figure 15 — the Add a New Entry / Exit Point window
3. In this example please note the following;

e The New Entry Point check box has been selected. In the New Node text box
“NEW_ENTRY” has been entered as the new entry point name, and “HORNDON” has
been selected as the Existing Node.

e The Supply quantity (GWh/d) has been entered as zero (always zero for new entry
points).

e The Length of pipe (km) has been entered as zero (always zero for minimum
connections).

e The Obligate Entry Capacity has been entered as zero (always zero for new entry
points).

e The Number of Incremental Steps and Step Size have been entered as zero. (The
number of incremental steps multiplied by the step size should equal the size of the
new entry point.

Please refer to the Incremental Entry Capacity Release Methodology Statement, which
can be accessed at the following links, for details on selecting the number of required
increments and size of step.

http://www.nationalgrid.com/uk/Gas/Charges/statements/

http://www.nationalgrid.com/NR/rdonlyres/3FE02C8B-3FC1-40E0-9528-
F2ED634015AD/44391/IECRv11approvedi.pdf

e The CV has been left at its default value of 39.6MJ/m3, however users can amend this
if the actual figure is known.

e Minimum Flow has been left at zero (always zero for new entry points).

¢ The Connection Cost has been left at zero (always zero for a minimum connection).

4. Select Populate and Close.
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The result is that “HORNDON” has been added to the bottom of the Pipe Data section in
column B as has the new entry point, “NEW_ENTRY”, which will be connected to the network
as shown in Figure 16.

B3 Microsoft Excel - Transportation Model Oct 2010 Exit MSEC new entry

4] Fie Edt Yew Iwet Fomat Ioos [Data Window Help Type @ question for help [+ = & X
N EHR GG TR S G P 8 F o E] e o [l -8 B 7 U|EEEG |y 5 50 & :
e 2 [t B v T < | (3] By {3 ] ¥ Reply with Changes... End Review.., !

B436 - A HORMDOM

A ] B 1] E F | G | H [ [ 3 | K [ L =
17| [rmerELD fakiFIELD_NT 0o 1098
418]  frmeFELD heakFIELD_SE 0 a0ee
415]  frmFELD heakFIELD_S0 o 8217
1420]  |m1SBECH_MENE_EAST hasBECH NENE WEST 022 000
1421]  #ISBECH_HENE_EAST lISBECH NEE WEST 023 a7
422|  WISBECH_MENE_WEST PETERBOROUGH_COMP_TEE w82 000
423]  [WISBECH_HENE_WEST FeTERBOROUGH_TEE 2535 28315
424 fwooLer cuvzance 4228 8045
425 fwooLer HUVBLETON 413 si54
426|  [moRMNGTON FooncTon 1433 -40.00
427 WoRMINGTON HonEVBOURNE 574 26571
428]  fwoRMInGTON sarpERTON 3575 30571
425  fwoRMINGTON sarpERTON 4200 000
H_D [WWORMINGTORN TIRLEY 2687 0.00
ﬂ ["WRAGG_MARSH [SPALDING PG 0.00 4200
52 [ TCH_FARM_TERMINAL MAPPOWDER 000 000
433 |veLverTon BRITISHSUGAR_CaNTLE Y o 000
434 |veLveg FOTELD 533 20534
435 TiGH:M jEST BURTON PS 0 5000
,% e ENTRY oug
437 ]
438
430
440
1441
442
443
444
445 |
446 |
447
48|
428
1450
1451
1452
1453
1454
1455
455 |
1457
1458
453 4
w « v nh Front Sheet ) Exit Capatity Prices /. Entry Capacity Prices / |« 3|
Resuks writken to HEW_SITE. s Count=3 CAPS NUM

Figure 16: the updated Pipe Data table
Note: you do not need to enter flow data in column E as this will be populated when the

Transport Model is run. Also note that the model is case sensitive i.e. “NEW_ENTRY” is
different to “New_Entry”, and separate words also need to be joined by using an underscore.
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5. Navigate to the Node Data table and you will notice that it has been updated with
“NEW_ENTRY” to the bottom of Node (column G), as shown in Figure 17. The supply and
demand values of “0.00” (GWh) have also been entered in columns H & | respectively (these
are always zero in the case of new entry points).

Note: you do not need to enter LRMC data in column J as this will be populated when the
Transport Model is run. This will happen within the Model and will not change the entered
data.
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Figure 17: the updated Node Data table

24




October 2011 NTS Transportation Model User Guide v3.0

6. Navigate to the Tariffs — Raw (Unadjusted) Entry and Exit Prices table (columns L — S).
You will notice that “NEW_ENTRY” has been added to the bottom of Eniry Point column
(column L), as shown in Figure 18, and that the following formulae from the row above have
been copied down to the new row entry;

Entry Flow (column M)
Entry LRMC (column N)
Entry Price (column O)

The cells may display “#N/A” but this is expected at this stage.
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Figure 18: the updated Tariffs — Raw (Unadjusted) Entry and Exit Prices table
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7. Click on Reset Ranges

8. Click on Clear LRMCs followed by Calculate LRMCs within the Transport Model controls.
9. Click on Reset Adjustment Factor followed by Calculate Entry Prices within the Tariff
Model controls (this calculates the adjusted LRMC and Unscaled Entry Capacity prices).
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Figure 19: Calculating LRMCs and Unscaled Entry Prices
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10. Navigate to the Entry Capacity Prices worksheet. You will notice that “NEW_ENTRY” has
been added to the first table and the previously entered data has also been populated into the
appropriate columns.

11. Click on Reset Ranges in the Entry Capacity Prices worksheet.

Note that “NEW_ENTRY” will not appear in the drop-down lists in the Analysis Tools section,
therefore you will need to Save, close and re-open the spreadsheet, which will allow the drop-
down list to refresh.
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Figure 20: The Reset Ranges button and Analysis Tools controls
12. Then either:

a. Select the desired entry point from the drop-down list in the model controls (columns M
—0O) and click on Analyse Selected Supply.

Or;
b. Click on Analyse All Supplies within the model controls.

The Nodal Marginal Distance, Initial Price Schedule and Final Price Schedule tables will all be
updated for the selected supply/all supplies.

The Final Price Schedule is determined by adjusting the Initial Price Schedule to ensure there
is a minimum price step size between successive price steps.

Note that the Transportation Model will generate an Excel file for each supply point that is
considered - the files will be saved in the same location as the Transportation Model. The
generated files do not need to be viewed - they contain more detailed data, which is used to
populate the Entry Capacity Prices sheet within the Transportation Model.
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8. Contact Details

If you experience any difficulties using the model, please e-mail our Charging Team on 01926
654 633 or e-mail charging.enquiries@uk.ngrid.com.
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Appendix 1: “Exit Capacity Prices” Worksheet - Understanding the
Transport and Tariff Model Controls

The controls for the Transport and Tariff Models are described below, in the order that they
appear as you navigate across the spreadsheet from left to right

Reset Ranges
This function resets the range names within the spreadsheet. Therefore it is only necessary to
use this function if Nodes, Entry Points, Exit Points or DN Zones are added by the user.

Transport Model

Reference Node

It is possible to select a different reference node via the drop-down list of nodes in the
network. This will only affect the initial marginal cost values but not the final tariff values.
Adjustment of the marginal costs to achieve a 50:50 entry-exit split, or to meet a Target Exit
Revenue, will re-reference the marginal costs, so the final tariffs are unaffected.

Clear LRMCs

It is good practice to clear the LRMCs from a previous calculation before recalculating,
especially if more advanced scenario analysis is being undertaken (see below). This clears
the LRMC values from the nodal data section and also clears the flow results from the pipe
data section.

Calculate LRMCs
This calculates a set of LRMCs and writes the results in the Node Data section.

Tariff Model — Raw (Unadjusted) Prices

Annuitisation Factor
The Annuitisation Factor may be changed. The default value of 0.10272 is the annuitisation
factor in National Grid’s NTS Licence for the formula period 2007-2012.

Expansion Constant

The Expansion Constant may be changed. The default value of £2559/GWh km is that used
in the published indicative charges for the charging consultation GCMO01 and discussion
GCDO01, available at http://www.nationalgrid.com/uk/Gas/Charges.

Reset Adjustment Factor
The adjustment factor should always be reset to zero before calculating new entry and exit
prices, to ensure consistent calculations are performed.

Calculate Entry Prices

This calculates a set of entry and exit prices based on a 50:50 entry-exit split. The results are
displayed in the Tariffs — Raw (Unadjusted) Entry and EXxit Prices section of the spreadsheet.
This calculation has been used to determine all baseline and incremental entry prices for
GCMO01 and all exit prices for GCDO1 (enduring exit prices).

Average Entry LRMC
This is the average of the adjusted entry LRMCs such that all negative adjusted LRMCs are
collared at zero or 0.0001.

Average Exit LRMC
This is the average of the adjusted exit LRMCs such that all negative adjusted LRMCs are
collared at zero or 0.0001

Adjustment Factor

A constant Adjustment Factor is added to each entry point LRMC and subtracted from each
exit LRMC such that the average of the entry costs equals the average of the exit costs, and
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on average a 50:50 split of charges between entry and exit is achieved. The built in Excel
Solver is used to perform this calculation.

Avg. Entry — Average LRMC

This is the difference between the Average Entry LRMC and Average Exit LRMC, and is used
in the Excel Solver to find the Adjustment Factor. This value should be zero (or very close to
zero) when the final entry and exit prices are calculated.

Tariff Model — Administered Exit Prices

Target Exit Revenue

In order to calculate administered exit charges, a Target Exit Revenue figure must be set (in
£m), to reflect the proportion of TO allowable revenue to be collected from exit capacity
charges.

Implied Exit Revenue

Prior to the adding of the Revenue Adjustment Factor, the Implied Exit Revenue is the total
exit revenue generated if the exit charges were calculated using the LRMCs in column J.
(Please note the LRMCs in column J are Entry LRMCs and therefore to calculate Exit
Capacity charges the opposite value is used i.e. positive Entry LRMCs become negative Exit
LRMCs and vice versa). The Excel Solver is used to find the Revenue Adjustment Factor
such that the Implied Exit Revenue equals the Target Exit Revenue.

Adjustment

The Revenue Adjustment Factor is a constant added to each LRMC value to generate a set
of exit charges that will collect the Target Exit Revenue. The Excel Solver is used to find the
value of the Revenue Adjustment Factor.

Target — Implied Exit Revenue

This is the difference between the Target Exit Revenue and Implied Exit Revenue used in the
Excel Solver to find the Revenue Adjustment Factor. This value should be zero (or very close
to zero) when the final administered charges are calculated.

Reset Revenue Adjustment Factor
The revenue adjustment factor should always be reset to zero before calculating new exit
charges, to ensure consistent calculations are performed.

Calculate Exit Prices

The Excel Solver is used to adjust the revenues arising from exit charges to match the Target
Exit Revenue. The final charges are then displayed in the Tariffs — Administered Exit Charges
section of the spreadsheet.

Selection of Exit Charges
Individual exit points may be selected via the drop down list. Alternatively, the exit charge
results may be viewed in the Tariffs — Administered Exit Charges section of the spreadsheet.

Selection of Zonal Charges

DN charging zones may be selected via the drop down list. Alternatively, the zonal exit charge
results may be viewed in the Tariffs — Administered Exit Charges section of the spreadsheet.
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Appendix 2: “Exit Capacity Prices” Sheet - Further Details

Transport and Tariff Model Controls
The controls for the Transport and Tariff Models are linked to the macros used to automate
the spreadsheet calculations.

Pipe Data (Columns B - E)

The first set of data describe the pipes in the underlying network model i.e. pipe inlets, pipe
outlets, and pipe lengths. Flows through pipes calculated by the Transport Model are also
written to this section of the spreadsheet. Note that where more than one route between two
nodes of the network exists, the Transport Model chooses the one that has the least cost (in
terms of flow distances) so some pipe sections will have no flow through them. If a negative
flow value is calculated, it means that the flow is reversed in the pipe i.e. from “outlet” to
“inlet”.

Node Data (Columns G - J)

Node Data is shown to the right of the Pipe Data and comprises node names, supply flows
into the node, demand flows out of the node and LRMCs calculated from the Transport
Model. The reference node is shown above the node data, as well as totals for the nodal
supply and demand data.

Tariffs — Raw (Unadjusted) Entry and Exit Prices (Columns L - S)

The data and results to the right of the Node Data are used for the calculation of unadjusted
entry and exit prices. There are two blocks of data: one for entry and one for exit. The
information is ordered as follows: the entry/exit point names, supply/demand flows referenced
from the Node Data section, adjusted values of the LRMCs and prices in p/kWh/day. The
adjustment to LRMC values is made so that, on average, 50% of charges are levied on entry
and 50% on exit.

Tariffs - Administered Exit Prices (Columns U — AC)

The second tariff model uses the data to the right of the Tariffs — Raw (Unadjusted) Entry and
Exit Prices section. The data is ordered as follows: exit point name, baseline, revenue
generated at exit point (assuming the demand flow at the point), and exit charge. The
remaining data (DN zone etc.) is used to calculate the flow weighted charge applicable to DN
users up to 30" September 2012. After this date DN offtake specific prices will apply.

A flow is attributed to the Bacton - Zeebrugge Interconnector to account for firm exit capacity
at this point.
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Appendix 3: “Entry Capacity Prices” Sheet — Further Details

Initial Data Table (Range B19 — K41)
The first set of data contains the information relevant to calculating incremental entry capacity
charges. “Number of Incremental Steps” (column F) needs to be populated by the user.

Incremental Entry Controls (Range M25:038)

The Analyse Selected Supply and Analyse All Supplies buttons are linked to macros used to
automate the spreadsheet calculations. The required entry point can be selected from the
drop-down list. Each time a new entry point is selected the “Reset Ranges” button should be
used.

Selection of Entry Prices
Individual entry points may be selected via the drop down list.

Nodal Incremental Distances (Range B24:X76)

The first set of data below the Initial Data table contains the Nodal Incremental Distances.
Nodal Marginal Distances for the selected supply point/all supplies are converted to Nodal
Incremental Distances by calculating the difference between the Nodal Marginal Distance at
the incremental level and the Nodal Marginal Distance at the obligated capacity level.

Initial Price Schedule (Range B89:X111)

The Nodal Incremental Distances are converted to capital costs by multiplying by the
Expansion Constant, and annuitised according to the annuitisation factor specified in the
Licence. Annuitised costs are converted to p/kWh/day and adjusted to recognise the different
calorific values of gas entering the system. The initial incremental step price is calculated by
adding the annuitised cost for the incremental capacity step to the obligated entry capacity
reserve PO price.

Final Price Schedule (Range B124:X146)

The process for determining the Initial Price Schedule will usually result in an increasing price
progression with increasing capacity level. However, a price progression that decreases with
the incremental capacity level may be observed. In order to test for the presence of an
ascending or descending curve, the price at the highest capacity level will be compared to the
P1 price. The final incremental step price is determined by ensuring that there is a difference
of at least 0.0001p/kWh/day between each incremental step price.

Estimated Project Value (Range B159:X181)

For the purposes of determining the required commitment from bidders that trigger the
release of incremental capacity an estimated project value is calculated for each incremental
capacity level from the final incremental step prices.
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Appendix 4: Using the Transportation Model in Excel 2007

Security Warning

In Excel 2007 there is no Security Warning dialogue box but the warning will be displayed

underneath the ribbon bar.

In order to be able to run the Transportation Model select Options to display the following

ey iCd

J’ Home || Insert | Page La)I Formu\al Data | Review iView | De\telop,'@ - B X
=5 W || Aral -0 - = % WA Ml )| = - 5
'j-ﬂ-‘g |B 1 U-||A A o #-
Paste T Alignment | Number| Styles || Cells 2
S o[- A = = = - | 2+
Clipbo... ™= Font = Editing
- = x
Q Security Warning  Some active content has been disabled. Options...
u21 - e | ™
A B C D E E. G H =
4 4 » ¥ | Front Sheet .~ Fuit Cadl
Ready | 73 EELE e s
-

dialogue box, and check the Enable this Content control and click OK.

(|
I @ Security Alert - Macros & ActiveX

Macros & ActiveX

Macros and one or more ActiveX controls have been disabled. This active content might
contain viruses or other security hazards. Do not enable this content unless you trust
the source of this file.

‘Warning: It is not possible to determine that this content came from a
trustworthy source. You should leave this content disabled unless the
content provides critical functionality and you trust its source.

More information

File Path: C:\...Documents\WorkModels{Transportation Model Oct 2010 Exit MSEC .xls

) Help protect me from unknown content {recommended)

Open the Trust Center

Solver Error

Some users may experience the following error when running the Transportation Model in

Excel 2007.

P

Microsoft Visual Basic Iﬂ

b

Compile error:

Can't find project or library

Help

To run the Transportation Model in Excel 2007 you may need to perform the following steps.

1. Enable the Developer tab by going into Excel Options>Popular, and selecting the Show

Developer tab in the ribbon check box.
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2. From the Developer tab select Visual Basic and from the Visual Basic window select

Tools>References

3. You will be presented with the window below. Deselect Missing.Solver.xla

s 5
References - NTSTransportationModel2006 {é]

Available References:

V| Visual Basic For Applications - Cancel
v Microsoft Excel 12.0 Object Library &

[V OLE Automation =
| Microsoft Office 12.0 Object Library Browse...
[l Microsoft Forms 2.0 Object Librar:
Gssie sovea ———— JENEY
_|S0LVER
[ AccessibilityCpladmin 1.0 Type Library
Acrobat Access 3.0 Type Library Help

AcroBrokerLib i]
[] AcrolEHelper 1.0 Type Library
AcrolEHelpershim 1.0 Type Library
[ Active DS Type Library =
[ ActiveMovie control tyne lihrary

4 n

MISSING: SOLVER.XLA

Location:  C:\Program Files\Microzoft Office\OFFICE 11'Library\SOLVER ¥
Language: Standard

4. Select Solver just beneath it.

5. Click OK, and close the Transportation Model saving changes.
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